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Preface

Information Technology (IT) is so important in the world today that it
makes it imperative for every person to be competent in the use of IT
for the many tasks that one will have to accomplish. It is with notion
that this book is written to provide the basic skills in IT for Grade 8
students of the Federal Democratic Republic of Ethiopia. It is expected
that the knowledge and skills gained through this book will help the
students to use IT in almost all their subjects at school and in their
everyday life. The book covers selected basic topics in IT, which offer
hands-on activities to help students in acquiring the required IT skills.
The key features of this book will help the students to:

o describe the historical development of computer and its develop-

ment from the earliest to the current periods,

o identify the generations of computer,

o identify computer hardware,

o identify the computer software,

 describe Internet services,

e describe computer ergonomics,

o program LOGO language.

The textbook has been designed in a simple and user-friendly way.
This text focuses on the fundamentals of IT, which change slowly. This
does not only make the information remain useful to a student when
one graduates, but also makes the student focus on the foundation
concepts in IT. This textbook also illustrates the latest developments
in the rapidly changing world of IT. Review questions have also been
given at the end of each unit.

Suggestions for the improvement of this book will be gratefully
acknowledged.
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Unit 1: Basics of Computer Grade 8

1 Computer

Unit Outcomes

At the end of this unit, students will be able to :
W identify computer generation;

W explain functions of the computer;
m  explain types of computer;
|

list characteristics of computer.

J .
Overview

In this unit, you will learn about basics of computer such as
generations, functions, types and characteristics of computer. The
evolution of computer is classified by its generations. The main
functions of computer are taking, processing, returning results,
and storing data. Computers are classified based on their size,
storage and speed, methods of the operation, and purpose of the
application. The characteristics of computer indicate the quality
of a computer.

A\ 4

% ®  Define the term computer as you learned in grade 7.
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— 1.1. Computer Generation —

Brainstorming activity

oo ™ Do you know the evolution of computer?

The term generation refers to the period of development of the
computers. Computer generation is change happened in the
development of computers. The evolution of computer is divided into
generations. Each generation is characterized by a major technological
development that changed the way computers operate. Initially, the
term generation was used to distinguish hardware technologies.
Nowadays, generation includes the changes in hardware and software.
There are five computer generations. These are:

A. First generation D. Fourth generation
B. Second generation E. Fifth generation

C. Third generation

1.1.1. The First Generation (1940-1956)

The earliest generation of computer is the first generation. The first
generation of computer used a vacuum tube for electric circuit.
The vacuum tube was a basic component of the first generations of
computer.

The first generation was large
and very expensive computer, as &
shown in Figure 1.1. It needs high (%8
power of electricity and generates &
a lot of heat. ;

Figure 1.1. The First Generation of Computer

The first generation of computers used vacuum tube as a core of
technology, as shown in Figure 1.2 below.
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f

D + Vacuum tube is an electronic
device that controls the flow of
electronsin a vacuum.

Figure 1.2. Vacuum Tube

1.1.2. The Second Generation (1956-1963)

The second generation of computer used transistor as the basic
component. The transistor, as shownin Figure 1.4 below, was invented
in 1947 but was not seen widely spread to be used in computers until
the late 1950s. o -

Figure 1.3. The Second Generation of Computer @

+ Transistor is an electronic
device used to control the
flow of electricity in electronic
equipment.

Figure 1.4 Transistors

1.1.3. The Third Generation (1964-1971)

The third generation of computer is a computer that emerged due to
the development of the integrated circuit (IC).
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ihe deveiopment of the iC was
the characteristic of the third
generation of computers.

Figure 1.5. The Third Generation of Computer

AnICreferstoasmallelectronic device developed from semiconductor
materials. An integrated circuit is the core of technology that is used
in the third generation of computer, as shown in Figure 1.6 below.

% Integrated circuit is an
integrated system of multiple,
small and interconnected
components.

Figure 1.6. Integrated Circuit \_)

1.1.4. The Fourth Generation (1971-Present)

The fourth generation of computer is the progressive version of
the third generation of computer, as shown in Figure 1.7 below.

The fourth generation of computer
used very large scale integrated
(VLSI) circuit. VLSI is the current
level of computer microchip
containing hundreds of thousands
of transistors. It is more powerful,
compact sized, reliable, and
affordable generation of computer.

Figure 1.7. The Fourth Generation of Computer

The fourth generation of computer is suitable to have in the palm of the
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hand. As a result, it gave rise to the revolution of Personal Computer
(PC).

([ * Very large scale integrated
circuit is the current level of
computer microchip containing
hundreds of thousands of
transistors.

Figure 1.8. Microprocessor

1.1.5. The Fifth Generation (Present and Beyond)

The fifth-generation of computer uses Artificial Intelligence (AI)
applications such as robotics, game playing and natural language
processing. The goal of the fifth generation of computer is to create
machines that can learn and organize themselves. The development
of the fifth generation of computer is intended to solve complex
problems. The fifth-generation of computer has the ability to perform
parallel data processing; which helps to develop Al applications.
The parallel processing is used to enable the computer to achieve
simultaneous data processing tasks to increase the mathematical
calculation speed of a computer system. The parallel processing
system can carry out simultaneous data processing to achieve a faster
execution time. The primary purpose of parallel processing is to
enhance the computer processing capability and increase the amount
of processing accomnlished at a given time interval. )

(0 + Artificial intelligence refers
to the simulation of human
intelligence in machines that
are programmed to think like
humans and mimic their actions,

Figure 1.9. Example of the Fifth Generation of Computer
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Activity 1.1

®m  Discuss the time range of inventions and key differences
between generations of computer in groups.

— 1.2.  Functions of Computer —

Brainstorming activity

® How do you associate the functions of computer in
processing data with that of human mind?

There are four basic functions of computer. These are:

e Input ¢ Output
* Process e Storage
1.2.1. Input

Input is a process of inserting data into a computer. A computer takes
data from the user in order to process and store it. For example, to
find the product of numbers, the computer first takes the numbers as
an input from a user. The data can be entered into computer maybe by
typing from keyboard, taking picture, using cameras and recording
audios.

1.2.2. Processing

Processing is making some operations on the entered data. For
example, a computer can take two numbers and calculate their sum.
You can also take photo editing as an example. You can make change
in colors, borders and brightness of your photo to make it more
beautiful. Moreover, you can see your roster preparation. Computer
can take the students” marks as input and calculate the average, select
top students as well as total marks.

1.2.3. Output

Output is displaying the result obtained from processing to the users.
The output can be displayed through monitor, speaker and printer.
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For example, the printer can print the output of roster processing on
paper.

1.2.4. Storage

Computer is used to store data. The storage can be a computer’s
internal or external storage. Storage usually occurs on a hard drive,
flash drive, and a compact disk (CD). For example, you can save
your photo on your mobile memory, videos on CD, and your roster
on computer hard drive. The four basic functions of computer are
presented in the Figure 1.10 below.

Process
Storage

Figure 1.10 Functions of computer

Activity 1.2

m  Discuss how computer works in a group?

— 1.3.  Types of Computer —

Brainstorming activity

&h
% ® Do you know the types of computer?

Computers can be classified based on their size, storage, speed,
methods of operation, and purpose of application.
I. Types of computer by their size, storage and speed

Based on their size, storage, speed there are four types of computer:
B  Microcomputer B  Mainframe computer

B  Minicomputer ®  Supercomputer
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1. Microcomputer

Microcomputer is a small sized computer used for general purpose.
Microcomputers are the most widely used type of computers. They
are small and fit on desktops, have varying capacity and easy to
handle. Microcomputers are referred to as Personal Computers (PC).
They have video display unit for output purpose. Data can be entered
through the keyboard and stored on different storage devices such as
removable disk, compact Disk (CD) and external hard disk.

Personal computers (PCs) are the popular form of such computers
used by different individuals as well as organizations. The PCs are
classified as:

A. Desktops: These are the computers whose case sits on a desk
with its keyboard in front of it and its monitor often on top,
as show in Figure 1.11 A. There are also desktop computers,
which do not have separate system unit and monitor. Both sys-

tem unit and monitor are integrated in one device, as shown in
Figure 1.11 B below.

Figure 1.11: A. Desktop with a system B. Desktop with IntegratedSystem
unit and monitor unit and Monitor

B. Portables:

These PCs are so small that they can be placed in a handbag.
The difference between portables and desktops is that
portables can be carried while traveling unlike desktops.
The portables are also classified as:
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i.  Laptops: These small sized S
computers having the same
power as a desktop. they are small
enough to carry and designed for
use outside an office, as shown in
Figure 1.12.

Figure 1.12: Laptop

ii.  Notebooks: These are
smallerthanalaptopanddesigned
to overcome the drawbacks of a
laptop. They have the size of agm
notebook but they are as powerfulfl]
as a desktop, as shown in Figure
1.13.

iii. Tablet:isaportable personal
computer with a touch screen. A
tablet is typically smaller than a
notebook computer, but larger
than a smartphone. A smartphone
is a portable device that combines
mobile telephone and computing
functions into one unit. The

touch screen display operates
bya finger instead of the mouse,
touchpad, and keyboard of larger
computers, as shown in Figure
1.14.

Figure 1.14: Tablet



2. Minicomputer
Minicomputers are larger

and more powerful than
most microcomputers,
but smaller and less
powerful than mainframe
computers. They are small
and general-purpose
computers.

Figure 1.15: Minicomputer

3. Mainframe Computer

Mainframe computers are large and powerful computers that are

physically larger than microcomputer and minicomputer.
These computers have

processors with faster
instruction processing speeds.
Mainframe computers process
data at very high rates of
speed, measured in millions
of instructions per second.
Mainframes are designed for
many users and can be used at a
time and process vast amounts
of data quickly. For example,
banks, insurance companies,
manufacturers, and airlines
are typical users of these
computers.

Figure 1.16: Mainframe Computer

10
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4. Supercomputer

Supercomputerisahigh-speed processing computer. A supercomputer
is characterized by fastest speed, and most powerful capacity. This
computer is capable of processing trillions of instructions per second.
Supercomputers are largely used by research organizations, military
defense systems, national weather forecasting agencies, large corpo-

rations, and aircraft manufacturers.

Figure 1.17: Supercomputer

I1. Types of computer based on their methods of operation

Based on methods of operation, this category of computers has three

types:
1. Analog Computer 3. Hybrid Computer

2. Digital Computer and



A.Analog Computer

Analog computer is a type of computer that was used to process
continuous data. Analog computer was used in the 1950s and 1960s.
It has limited memory and store less amount of data. It works
with continuous data rather than discrete values. For example,
analog computers used to process continuous values such as speed,
temperature, pressure and current.

Analog computers directly accept the
data from the measuring device without
first converting it into numbers and
codes. They measure the continuous
changes in physical quantity and
generally provide output as a reading -
on a dial or scale. Speedometer and — A
mercury thermometer are examples of

analog computers.

Figure 1.18: Analog Computer (Heartrate Monitor Machine)

B. Digital Computer

Digital computer was designed to perform calculations and logical
operations at high speed. Digital computers transmit the data on a
discrete value.Itacceptstheraw dataasaninputinthe formof digitsand
processes it with programs stored in its memory to produce the output.

Figure 1.19: Digital Computer

12
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C. Hybrid Computer

Hybrid computer has characteristics of
both analog and digital computer. It is
fast like analog computer and accurate
like digital computers. It can process both
continuous and discrete data. It accepts
analog signals and converts them into
digital form before processing. So, it is
widely used in specialized applications
where both analog and digital data is
processed. A processor used in a petrol
pump that converts the measurements
of fuel flow into quantity and price is an
example of hybrid computer. Similarly ,
it is also used in airplanes, hospitals, and Figure1.20: Hybrid Computer
scientific applications.

I11. Types of computer based on their purpose of application

Computers can be used for different purposes. Based on their
application, they are classified as special purpose or general-purpose
computers.

A. Special Purpose Computers

Special purpose computers are designed to solve a single problem.
Their components and their functions are uniquely adapted to a
specific situation involving a specific application.
Examples:

®m  The public telephone box
Road Traffic control and safety system
Ticket machines (for example in grocery and super market.)
Pocket-calculators and

Counters.
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B. General Purpose Computers

General-purpose computers are designed to solve a variety of
problems. They are programs or set of instructions designed to solve a
problem. General-purpose computers are more flexible and versatile.
Examples include:

®  Microcomputers
B  Minicomputers

®  Supercomputers.

Activity 1.3

®  Form a group and discuss the differences between ana
log computer and digital computer based on the data
they operate.

— 1.4.  Characteristics of Computers —

Brainstorming activity

g@é ®  What are the major characteristics of computer?
Characteristics of computer indicate the qualities, limitations and
features of a computer. There are various characteristics of computer

depending on their size, capacity, and specifications.
Major characteristics of computer are:

e Speed: A computer works very fast and at high speed while
performing mathematical calculations as compared to hu-
mans. For example, to perform mathematical calculations,
the computers can process millions of instructions per sec-
ond. The time taken by computers for their operations is mi-
croseconds and nanoseconds.

e Accuracy: Computers perform calculations with 100% accu-
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racy. Errors may occur due to data inconsistency or inaccu-

racy.

e Diligence: A computer is free from tiredness. It does not feel
any fatigue or lack of concentration.

e Versatility: refers to the capability of a computer to perform
different kinds of works with same accuracy and efficiency.

e Reliability: A computer is reliable as it gives consistent re-
sult for similar set of data.

e Automatic: Computer performs all the tasks automatically
i.e., it performs tasks without manual intervention.

e Power of remembering: Computer has the power of storing
any amount of information or data. Any information can be
stored and remembered as long as you require it, for a long
period.

e No IQ: Computer cannot do any work without instruction
from the user. Thus, it does not have 1Q (Intelligence Qua-
tient).

e No Feeling: Computer does not get tired even after long
hours of work. Computer does not have a feeling or emotion,
taste, knowledge and experience.

e Storage: Computer has a capacity to store a large amount
of data. The Computer has an in-built memory where it can

D

+ No Intelligence Quatient (IQ): Computers cannot
work by their own unless a set of instructions are
given to it.

1 < No Feeling: Computer does not have feelings and
emotions. Although it has memory, it cannot work
like a human brain. it

store a large amount of data.

9
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Summary

In this unit, you have learnt about generations, functions, types and
characteristics of computers. The following points are summary of
this unit.

Computer is an electronic device, which accepts instructions
in order to perform certain tasks.

The evolution of computer is defined in terms of the five
generations of computer.

Each generation of computer is categorized based on a new
technological development, low price and small size, more
powerful operation, fast speed and functionality.

A smartphone is a portable device that combines mobile
telephone and computing functions into one unit.

There are four basic computer functions: accepting input,
processing, providing output and storing data.

Computers can be classified based on: size, methods of
operation and purpose of application.

Types of computer based on size are microcomputer,
minicomputer, mainframe computer and super computer.

Types of computer based on method of operation are analog,
digital and hybrid computer.

Types of computer based on purpose of application are
special purpose and general-purpose computer.

Characteristics of computer are speed, accuracy, diligence,
versatility, reliability, automation, power of remembering,
no IQ and capacity to store more data.
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Review Questions

Part I: Say “True” if the statement is correct and “False” if it is in-
correct.

1. A supercomputer is the fastest, most powerful, and most expen-
sive type of computer.

2. The computers that used transistors are called the First Genera-
tion Computers.

3. The third generation computers used integrated circuits.
4. Personal computers are also called microcomputers.

5. Computers provide a perfect and accurate result even when
wrong data is entered.

Part I1: For each of the following questions choose the correct answer.
1. The acronym PC stands for:

A. Private Computer C. Personal Compact
B. Personal Computer D. All
2. Which one is the most powerful type of computer?
A. Minicomputer C. Mainframe computer
B. Microcomputer D. Supercomputer
3. is the way a computer accepts data from the user a
A. Input C. Output
B. Process D. Storage
4. Which one is not a characteristic of computer?
A. Versatility C. Analog
B. Reliability D. Storage
5. Computers are designed to solve a single problem.
A. General purpose C. Special purpose
B. Supercomputer D. All
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Part III: Match column “A” with their corresponding description

stated under column “B”.

A . B .
First Generation

. Artificial Intelligence

o Second Generation
. Integrated Circuits , .
Third Generation

Fourth Generation

1
2
3. Vacuum Tubes
4 Fifth Generation

m o nNn= >

. Transistors

5. Microprocessors

Part IV: Read the statements and fill the blank space.

1.

The evolution of computers is mainly divided into

main generations.

Each new generation of computers resulted in decrease in

and

The computers that used were called the first genera-

tion computers.

computer generation will have the power to learn and

apply knowledge to solve a problem.

has characteristics of both analog and digital computers.
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2 Hardware

Unit Outcomes

At the end of this unit, students will be able to :
®m  explain hardware components of computer;

W identify input, output, storages and processing devices ;

W explain functions of input, output, storages devices processing.

J .
Overview

In this unit, you will learn about hardware categories based
on information processing such as input, output, storage and
processing devices and their functions. Computer system is
composed of computer hardware and software. Computer
hardware is the physical part of a computer that we can see by
our naked eyes and touch by our hand. It is divided into four
categories based on information processing; input, processor,
storage and output devices.

A\ 4

® Do you recall the components of computer
% hardware that you learned in Grade 7?
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—1 2.1.  Input Devices —

Brainstorming activity

@ m  Before we start our lesson today, can you list input
devices? And discuss what is the function of each
devices?

Input devices are computer hardware that are used to enter a data
to the computer. they convert the data into the form that can be
understandable by a computer as 0 and 1. The following are some of
input devices:

®  Keyboard m  Optical Speech

m Mouse Recognition

M Scanner m Joystick

m Optical Recognition W Light Pen
Systems ® Touch Screen

A.Keyboard

Keyboard is an input device which has keys that enable one to enter
data into a computer.

F6 F7 F8 Fg9 F10 Fll1 Fi12

Figure 2.1: Keyboard

The keys on the keyboard can be divided into several groups based
on their function as follows.



. Escape Key (ESC): Esc is a key found on the top-left corner of a
computer keyboard. It allows the user to cancel, or close an oper-
ation.

. Backspace Key: The back space key is a keyboard key that
deletes any character before the cursor>s current position.

. Function keys: The function keys are used to perform specific
tasks, for instance F1 is mostly used as the help key.

. Navigation and Editing Keys: These keys are used for moving
around in the documents. They include the arrow keys, Home,
End, Page Up, Page Down, Delete, and Insert buttons.

. Typing (alphanumeric) keys: These keys include letters, num-
bers, punctuation marks, and symbol keys found on a traditional
typewriter.

. CTRL Key: These keys are used alone or in combination with
other keys to perform such tasks as bold, italic, underline, save,
copy, cut and paste.

. Windows Key: Most keyboards have the Windows key near
the Ctrl key. If you tap the Windows key, it opens the Start Menu.
Then press the Windows key again to close the Start Menu. In
addition Windows key with others keys perform different activi-
ties, for example, Windows logo key plus D display the desktop,
Windows logo key plus E open computer and Windows logo key
plus L lock your computer or switch users.

. ALT Key: The alternate key provides alternate input and opera-
tions when pressed in combination with other keys.

. Directional Keys: There are four keys on a computer keyboard
with arrows up, down, left, and right.

10.Numeric Keypad: The numeric keypad is used for entering

numbers quickly. The keys are grouped together in a block like
calculator or adding machine.

21
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Escape Function Keys Backspace Navigation and
Key (ESC) (F1-F12) Key Editing Keys

—
)
7
-
[}
1
-
°
-

SNENAREARADSESF

Directional Keys

Windows Key
Numeric Keypad
CTRL Key

Figure 2.2: Parts of Keyboard

B. Mouse

Mouse is a hand operating device which controls the movement of
the cursor or pointer. Its name is derived from its shape, which looks
like a bit a mouse. The mouse are commonly has three buttons.

1. Left-button: used for left click. e.g. to select text

2. Right-button: used for right click. e.g. to see the property of the
file

3. Middle button: used for scrolling purpose. This button is some-
times missing.

Scroll Wheel & Middle Button

Left Mouse Button

Right Mouse Button

Figure 2.3: The mouse buttons
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Mouses are connected to the system unit by a cable (wire) or by
wireless. The wireless is also called cordless mouse or wireless mouse.
The mouse pad is a pad on which you can move a mouse.

C. Scanner

Scanner is an input device that accepts printed text, handwriting or an
object and converts it to a digital document.

It is used to input data directly
into the computer from the source
document without copying and
typing the data. The input data to
be scanned can be a picture, a text
or a mark on a paper.

Figure 2.4: Scanner

D.Optical Recognition Systems (ORS)

ORS uses light to read characters, codes, and marks. It converts them
into a computer understandable format 0 and 1. There are many types

of optical recognition systems.
1. Optical Character Recognition

2. Optical Mark Recognition
3. Barcode Reader

1. Optical Character Recognition (OCR)

OCR device is a scanner that reads typewritten, computer printed, and
in some cases hand written characters from ordinary documents. It
scans the shape of the characters and compares it with predefined font
shapes found in memory. It can convert the characters into computer
code comparison. It is used to enter documents found on paper into
computer without the need to type it using a keyboard.
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Figure 2.5: Optical Character Recognition

2. Optical Mark Recognition (OMR)

OMR device senses the presence or absence of a mark such as pencil
marks. It does not identify letters of the alphabet, instead, it uses electronic
scanners, marks and symbols. It converts marks and symbols into
appropriate electronic signals.

OMR is used to correct exams.
The read mark is interpreted
and matched against
previously entered answer
key. For example, Ethiopian
School Leaving Certificate
Examination = (ESLCE) is
corrected using this device.

Figure 2.6: Optical Mark Recognition (OMR)

3. Barcode Reader

Barcode reader is used to read barcodes printed on products. There
are different kinds of barcodes; the most commonly used one is
called Universal Product Codes (UPC). It is used to identify product
manufacturer and product number; for instance, they are found in
library management and inventory control management.



1234567890121,

Figure 2.7: a. Barcode b.Barcode Reader

E. Speech Recognition System (SRS)

SRS is the ability of computers to recognize human speech. The
microphone is used to enter the speech into a computer. The computer
then processes the speech and performs the action ordered by speech.
It is used to enter the data using speech instead of typing from
keyboard. This makes data entry very easier. It is the latest technology
and is still under research.

F. Light Pen

Light penis a light sensitive device
used together with a computer
monitor. It is us ed by touching
the screen with this device when
creating or modifying graphics. A
light cell at the tip of the pen senses
light from the screen to determine
the pen’s location on the screen.

Figure 2.8: Light Pen

G.Touch Screen

The touch screen allows us to enter data by using finger. Touch screen
is useful alternative to use a mouse or keyboard.

25
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It is used on a variety of devices,
such as a laptop, smartphone
and tablet. Touch screen is
generally used in applications like
Automated Teller Machine (ATM),
public information computers
hospitals, airline reservation and
railway reservation.

Figure 2.9: Touch Screen
H.Joystick

Joystick is a device which is commonly used for playing video games.

Joystick is mainly used to control
the speed of the cursor and is thus
popular in games involving speed
like racing and flying games. The
direction of push of the stick and
the amount of deflection determines
the change in the position and the
change in speed, respectively.

Figure 2.10: Joystick

Activity 2.1

®  Name at least three input devices and state its function?
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— 2.2.  Processing Devices —

Brainstorming activity

< ®  What do you mean when we say process devices?

% What do they do?

When a computer receives data from an input device, for example
from the mouse or keyboard, the data must be processed before it
goes to an output device, such as the printer or monitor. A processing
device is used for converting that data into useful information. For
instance, Central Processing Unit (CPU) is a type of processing device.
It is also called a processor. It is like the brain of the computer.

It performs instructions in response
to commands. A processor’s speed
is measured in hertz (Hz). Hertz is
the standard unit used to measure
the processor speed. One Hz means
one cycle per second.

Figure 2.10: Central Processing Unit

The CPU performs instructions and the computer’s processing
activities. It functions the same purpose as the human brain. It is
called the brain of the computer.

The CPU has three sub-components.

1. Control Unit (CU)
2. Arithmetic Logic Unit (ALU)

3. Memory (Registers) Unit

The three sub-components are connected by a cable called a bus. It
facilitates communication between the parts. It is used to transfer data
between these sub- components.
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1. Control Unit

As the human brain controls the body, control unit controls the
computer. Control unit does not perform the instruction by itself. It
does not carry out instruction, but it directs other processing elements
to perform the instruction.

2. Arithmetic Logic Unit

Arithmetic Logic Unit (ALU) is used to execute instructions. It per-
forms two operations, namely Arithmetic and Logic operations.

Arithmetic operation is a mathematical operation like addition, sub-
traction, multiplication, and division. For example; if you give your
computer the instruction 2+3, this is included in arithmetic operation
and it is performed by Arithmetic Unit.

Logical Operation is concerned with the comparison of data. It in-
cludes operators such as less than (<), greater than (>), equal to (=),
less or equal to (<=), greater or equal to >=).

3. Memory unit (Registers)

When instruction is loaded from a main memory, it is placed first
in registers to wait instruction from the control unit. Registers are
temporary storage location for data prior to performance in ALU.

— 2.3. storage devices —

Brainstorming activity

@ m  Have you ever used storage devices? If so, could
% you describe the devices you used?

A storage device is any type of computer hardware that is used for
storing files. There are two types of storage devices. These are primary
and secondary storage devices.
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2.3.1. Primary Storage devices

Primary storage refers to the main storage of the computer or main
memory. It is used to stores program instructions and data. There
are three types of primary memory.

® Random Access Memory ;
®  Read Only Memory;

m  Complementary Metal Oxide Semiconductor.
1. Random Access Memory (RAM)

RAM is used to store data temporarily. It is also called read-
write memory or main memory or primary memory. The programs
and data that the CPU needs during the performance of a program
are stored in this memory. It is a volatile memory. The data on the
RAM is lost when the power is turned off.

Figure 2.11: Kandom Access Memory
2. Read-only memory (ROM)
ROM stores information permanently. It has a software program built

into it at the factory. It could not be changed or erased by the user but
read.

It is non-volatile, i.e., once
the data is stored in the
memory cannot be modified
or deleted read-only.

Figure 2.12: Read-only memory

The ROM contains special instruction that the computer uses when
it is turned on, for example, the instruction that starts the computer

and displays information on the screen.
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3. Complementary Metal Oxide Semiconductor(CMOS)

CMOS is used to store information when a computer shuts off. It
is found in several types of electronic components including CPU,
and digital camera.

2.3.2. Secondary Storage Devices

Secondary storage devices are also called auxiliary storage. Secondary
storage is a memory that is stored external to the computer. It is
mainly used for permanent and long-term storage of programs and
data. Secondary storage includes magnetic tape, magnetic disk and
optical disk tape punched cards, and punched paper.

Magnetic Tape

The magnetic tape was the primary method of storing large amount
of data during the 1950s and 1960s. Today they are used primarily for
data backup purposes.

Data backup is a data
that is stored in a different
place than the original
computer. This is to avoid
the danger of data loss
due to disasters. If the
original data is lost, the
copy will be used.

It consists of thin ribbon
plastic called tape. One
side of the tape is coated
with iron-oxide.

It stores the data by magnetizing and demagnetizing the tape.
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Magnetic Disk

Magnetic disk is the most widely used storage medium on all computers.
It consists of a round piece of plastic or metal the surface of which is
covered with magnetic material. It allows random access of information
and solve problem of slow access time commonly found in tape files. For
example: Hard disk.

Figure 2.14: Hard Disk

Hard disk is a magnetic disk made up of metal which can be fixed
in the system unit of the computer. It serves as a secondary storage
and enables very fast accessibility of data. Each disk is subdivided into
tracks and sectors on which the information is stored.

Optical Disk

Optical disk uses laser light to read or write data. They use high
powered laser light to burn on the surface of the disk to store data.
The burned-out part is called the pit, and the non-burnt part is called
land. Land may represent 0 while pit represented by 1. Compact Disc
(CD) and Digital Versatile Disc (DVD) are the two most common
types of optical disks.

i. Compact Disc (CD)

The CD can store 700 MB of information. Data is stored only on one
side of the disc. There are three basic types of CDs.

m  Compact Disc Read Only Memory (CD-ROM)
m  Compact Disc Recordable (CD-R)

m  Compact Disc Read-Write (CD-RW)

m  Compact Disc Read Only Memory (CD-ROM)
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CD-ROM is read only type of CD, i.e. we cannot write data on such
CDs or you cannot erase data from it. The data are only accessed or
read from these CDs.

Compact Disc Recordable (CD-R)

It is also called Write Once and Read Many (WORM). These kinds of
CDs can be written on once. But then after, you cannot rewrite on it
or erase data from it. After you first write data on such discs, then the
only thing you can do is to read data from them.

Compact Disc Read-Write (CD-RW)

CD-RW is also called erasable optical disc. You can write data as many

times as you want on such CDs. You can also erase or delete data from
such CDs.

Digital Versatile Disc (DVD)

DVD stands for Digital Versatile Disc. But some people mistakenly
call it Digital Video Disc.

It is a new technology that is introduced recently. It is similar to
CD except that it can store large amounts of data and it has narrow
tracks than CD. It can store 4.7-17GB of information.

Activity 2.2

m  List different types of storage devices and explain each of
them.
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— 24. Output Devices —

Brainstorming activity

@ ®  What is the function of output devices? Discuss
% with your classmate.

The output devices are used to get data out of a computer. They

convert information from computer understandable form to a human
understandable form, either in soft copy or hard copy. For example;
soft copy is displayed by the monitor and projector where as hard copy
is printed using printer. Monitor, printer, plotter, projector, speakers,
headphones and braille reader are some of the output devices.

Monitor
The monitor output device is used for displaying output to the user.

The monitor is the most frequently used output device. It consists of
a display surface called screen. The following are types of monitor.

1) Cathode Ray Tube (CRT) 3) Light Emitting Diode (LED)
2) Liquid Crystal Display 4) Gas Plasma Monitor (GPM)
(LCD)

1. Cathode Ray Tube Monitor (CRT)

CRT is a technology used in traditional computer monitors and
televisions.

Figure 2.15: An example of computer using CRT monitor
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2. Liquid Crystal Display (LCD)

Liquid crystal display is the most commonly used device in digital
watches, clocks, calculators, smartphones, desktop computers,
laptops, and television.

Figure 2.16: An example of television using LCD

3. Light Emitting Diode (LED)

LED stands for Light Emitting Diode. LED monitor, sometimes called
LED-backlit monitors, have great color and image quality, but it does
not have a good response time.

It is a flat screen computer
monitor, which stands for
light-emitting diode display
It is lightweight in terms

of weight. Nowadays, a

s LE O Mon|lor

wide number of electronic
devices, both large and
small devices such as laptoj
screens, mobile phones, TV:
computer monitors, tablets,
and more, use LED display:

Figure 2.17: An example of television using LED
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4. Gas Plasma Monitor

Gas plasma monitor (GPM) uses neon gas instead of liquid crystal.
The neon gas glows and

form picture. It is used in older
portable computers and television.

Figure 2.18: An example of television using gas plasma monitor

Printer

The printer is an output device that enables us to produce a hard
copy of data or information. It has different speed, capabilities, and
printing methods. Printers are divided into two classes based on the
way they print.

1. Impact printers, e.g.
Dot-matrix Printer and
Daisy-wheel Printer

2. Non-impact printer,e.g.
Ink Jet Printers, Laser
Printer and Thermal
printers.

. % w a w

Figure 2.19: Printer
Plotter

Plotter is used to produce high-quality drawings such as bar charts,
maps and banners. It produces high quality multi-color documents
on larger size papers which most printers cannot handle.

2 _3

s
Figure 2.20: Plotters
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Activity 2.3
m  Make a group; list out output devices and discuss
their function with your group members.
Summary

In this unit, you learned about computer hardware components such

as input, output, processing, and storage.

Input devices are any computer hardware equipment used
to enter the data to the computer.

Input devices are keyboard, mouse, scanner, micro phone,
electronic whiteboard, optical mark recogni tion, optical
character recognition, punch card reader, barcode reader,
joystick and pen input.

The output devices are used to get data out of a computer.

Monitor, printer, plotter, projector, speakers, head phones
and braille reader are some of the out put devices

Central processing unit (CPU) is the brain of computer

which performs computer instructions.

CPU has three subcomponents
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Review Questions

Part I: Read the following statements and say “True” if the statement

is correct and “False” if it is incorrect.

The speed of CPU is measured in only Megahertz.
CPU stands for Control Processing Unit.
Central Processing Unit acts as the brain of the computer.

Control unit performs Logic Operation.

A

Register is temporary storage location for data prior to execu
tion in Arithmetic Logic Unit.

6. Random Access Memory (RAM) contains essential information
that is required when the computer is turned on.

7. DVD stands for Digital Video Disc.

8.  Magnetic disk is the primary storage device.

9. Random Access Memory is the secondary storage device.
10. DVD store large amounts of data than CD.

Part IT: Choose the correct answer for each of the following questions

1. ____ allows you to enter data into a computer in the form of
text.

A.  Mouse C. Peripheral devices

B. Keyboard D.  Monitor
2. is an output device.

A.  Mouse C.  Joystick

B. Monitor D. None
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3. keys are present on the top row of
the keyboard.
A. Function C. Numeric
B. Typewriter D. Navigation

4. A light sensitive device that converts drawing, printed text or
other images into digital form is
A. Keyboard C. Scanner
B.  Plotter D. OMR

5. Which of the following groups consists of only input devices?

Mouse, Keyboard, Monitor
Mouse, Keyboard, Printer
Mouse, Keyboard, Plotter

Mouse, Keyboard, Scanner
6.  Which of the following is not an example of hardware?

oSNnwx

A. Scanner C. Monitor

B. Printer D.  Word Processing
7. The device that allow you to enter information into the com-
puter.

A.  Input C. Type

B. Output D.  Print
8. Which of the following is not an output device?

A. Plotter C. Scanner

B. Printer D. Monitor

9.  The most common method of entering text and numerical data

into a computer system is through the use of a
A. Plotter C. Printer

B. Scanner D.  Keyboard
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10.  Which one of the following optical recognition systems senses
the presence or absence of a mark, such as pencil marks?

A. Optical Character Recognition

B. Optical Mark recognition

C. Barcode Reader

D.None
11. The device that is primarily used to provide hardcopy is

A. CRT C. Printer

B. Computer Console D. Card Reader
12. converts information from machine-understand-
able form to a human understandable form.

A. Input C.CPU

B. Output D. Storage
13.  Which of the following is not a type of monitor.

A. Cathode Ray Tube C. Plasma Display

B. Liquid Crystal Display D. None
14. is most commonly used in digital watch-
es, clocks and calculators.

A. Cathode Ray Tube C. Plasma Display

B. Liquid Crystal Display D. None
15. is a device that enables us to produce a hard
copy of data/information.

A. Printer

B. Dot-matrix Printer
C. Daisy-wheel Printer
D. None
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Unit Outcomes

At the end of this unit, students will be able to :
W define operating system, utility and driver software;

W demonstrate skills in creating, saving, and formatting word
processing document;

r Software

®  demonstrate skills in creating, saving, and formatting spreadsheet;
W demonstrate skills in creating, saving, and formatting power point.

J .
Overview

In this unit, you will learn about operating system, word processor,
spreadsheet and power point. The formatting of word processor,
spreadsheet and power points are also discussed. The demonstrations
of word processor, spreadsheet and power point are presented in this

unit. Operating system, utility and driver software also addressed
here.

A\ 4

&% ®  What application software are you familiar
with?
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—1 3.1.  Operating system —

Brainstorming activity
oh ®  What do you notice about the operating system

%% you learnt in grade 7?

The operating system (OS) is software that communicates with the
hardware and allows other programs to run. OS is system software
that manages computer hardware and software. It performs all the
basic tasks like file management, memory management, process
management, handling input and output, and controlling peripheral
devices. It also provides common services for both hardware and
software. The applications require an OS to be functional. Examples
of operating systems are Windows, Mac OS, Ubuntu, Unix and Linux.

—1 3.2.  Utility Software —

Brainstorming activity

%% ® Do you know utilities software?

Utility software is system software used to solve a particular problem
of a user. It is included in operating systems as well as separately
available as a products like anti-virus. The purpose of utility software
is to manage tasks associated with the configuration, performance and
maintenance of a computer system. In other words, utility software
is usually used to manage system resources. For example, utility
software helps to perform backup, restore and anti-virus installations.
Operating system provides different types of utility software to resolve
common issues of software and hardware. Some of the utility software
are system utilities, storage management utilities, file management
utilities and miscellaneous utilities
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A. System Utilities: Some of the system utilities are:

B Anti-virus

m  Diagnostic programs and
m  Network utilities
A.

Storage Management Utilities: Some of the storage man-

agement utilities are:

m  Backup software
m  Disk formatters and
m  Disk partition editors
A. File Management Utilities: Some of the file management

utilities are:

m  Datarecovery
m  Data compression and

[ ] Data conversion

Activity 3.1

1. List and explain some of the system utilities, storage de
vices, management utilities, and file management utilities.

2. Download and install Avast anti-virus software on the
computer in the laboratory.
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—— 3.3. Driver Software —

on Brainstorming activity

% ®  How does a computer recognize a printer?

Driver software is a type of software that controls hardware devices
such as microprocessor, memory, hard drive, and peripherals devices.
The hardware devices use driver software to send and receive
information with other devices. The purpose of driver software is
to allow the peripheral devices to communicate with the operating
system. For example, printer driver is used to connect printers with
the operating systems. The modern computer is connected with
peripheral devices without physical connections using wireless and
Bluetooth technology.

— 3.4. Application Software —

Brainstorming activity

% ®  What does applications software use to edit

photo, browse and play music?

Application  software is a @ - : j {é

computer program designed to

help users to perform an activity. & A Q 8 /3

It is an application used to% @ l"‘ ;\1’/>

manipulate text, numbers, audio,

graphics, and a combination of @ @ @ ‘%QI\ @

these elements.

Figure 3.1: Some of applications software.

Application software has a specific purpose that is used for
particular tasks such as photo editing, an accounting application, a
web browser, a media player, a flight simulator and game.
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Activity 3.2
4 A

® Do you think that road traffic and safety light system, and
Automated Teller Machine (ATM) in your village need
software to work. Discuss in groups and present to your
class.

—1 3.5. Word Processor -

Brainstorming activity

% ®  Have you ever used word processor to edit files?

Word processor is a software that is capable of creating, storing, and
printing documents. It helps to create a document and make any
changes anywhere in the document. The document saved for later
use is opened on another computer when needed.

Features of Word Processor

I. Create Document

When word processor is clicked on, a blank document window
appears. Therefore, when a new document is created, its default name
will be displayed with the name DOCUMENT <number>, as it shown
in Figure 3.2 below.

Owords [ English (United States) E B B - 1 +  68%

Figure 3.2 New Word Document File Created
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II. Saving Document Using Save As

Once a document is created, it can be saved for future use. To “Save
as” means to preserve the document for next use. For example, to
“Save as” a word document, the following steps are needed.

1. Click the office File tab.
2. Click the Save As option.
3. Give it a file name, then click Save.

Type some sentences or a paragraph on word processor and go to the
File tab.

AutoSave (@ off) DI &

File Home Insert Draw Design Layout  References
/\& Cut | 2 | -~ v
[] CCalibri Body)  ~|11 ~ AT A" Aav A
[D Copy
Paste : " z TN NN
v < Format Painter B 1 X @b x, x| A =
Clipboard N Font N
L 1 : ' I . ' ! LY Al ' |

Figure 3.3. File tab

From the File tab, click on “Save or Save as” as shown in Figure 3.4
below.

Save As ]

@ Recent

E;l This PC

Save As

o AddaPlace

/

Browse

i L]

Figure 3.4. Selecting Save As to Save a file
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After you clicked on
Save as tab, you will
select where to save
file. For example, here
we select documents
directory to save it, as
it shown in Figure 3.5.

T save As
4 & > ThisPC > Documents

Organize > New folder

" "
= This PC Harre

3 3D Objects Folder A
= Desktop Folder B
%] Documents.
& Downloads
& Music

= Pictures

B Videos

£.05@ M €

Date modified Type Size

9/29/2018 11:46 A.

11/30/2018 2:08 PM  File folder

File folder

File name: | Example File Name|

Save as type: | Word Document

Authors:  Editar

[ 5ave Thumbnail

~ Hide Folders

Tags: Example Tag 4; Example Tag 5

Tools = Save Cancel

Figure 3.5 Saving a document

Finally, you have to provide file name and click on save tab, as it
shown in the Figure 3.5 above.

II1. Insert Text

The basic steps to insert text in word processor are listed below.
1. Click the word processor icon to open it.

2. You will see a Blinking cursor or Insertion point in the text
area below the ribbon.

3. Now, as you start typing, the words will appear on the

Screen in the text area.

4. To change the location of insertion point, press spacebar,

Enter or Tab keys. See Figure 3.6 below as an example.

Page1of1  26words

Addis Ababa Capital City of Ethiopia

Addis Ababa, Ethiopia’s sprawling capital in the
highlands bordering the Great Rift Valley, is the
country’s commercial and cultural hub.[

[ English (United States) B e B -

Figure 3.6. Inserting a text
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IV. Copy and Paste
Word processor offers different methods to copy and paste a text.
Some of the methods are given below: For example,
1. Select the text you want to Copy.

2. Select the Home tab and click Copy.See Figure 3.7 below.

892 U8 -

Mailings  Review View  Hel

File Home Insert Draw Design Layout References
o N - o _ _ o
[] EAC‘“ Calibri (Body) - - ATAT | Aar (R | ==y 232 2] | N
ey [IETST
Faste y A Q- A BE=== 1= 8-
- =¥ Format Painter B IU-axx A-£Z-4 == e e
Clipboard i Font T Paragraph ]
L b I Gt E (L T T S O N LW T |1 S O W T N S - S 0 W

Figure 3.7. Copy from Home tab
3. Place the Cursor where you want to Paste the text and

4. Click the Paste in Home tab. See Figure 3.8 below.

=] Q- -
File Home Insert Draw Design Layout References Mailings Review View  Hel
l::h V' i | . . o L _ o
] [’* Calibri (Body) ~(11 =~ A" A" |Aa~ fo | i=-i=-h=- (&=3= 2] €
o o
=] -G = e
~ BIU-abx X A-ZL-A- E===E & &2-H-

\9’ Format Painter
(P Paragraph

Font
' ' ' ' f ' |

Ta
o
l)_\)ll 2

Clipboard

LI T ' ' 1

Figure 3.8 Paste from Home tab
Alternatively, the following steps are important to copy and paste.

For example,
1. Select the text.

2. Place the Cursor over the text and Right click the mouse.
3. A menu will appear; with a left click select the Copy op-

tion.
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4. Now, move the Cursor to a desired location and Right
click the mouse.

5. A menu will appear; with a left click select the Paste op-

tion. See Figure 3.9 below.

AutoSave (@ Off) DOy B~ ~

File Home Insert Draw Design Layout References N

Calibri Body)  ~[11 ~ A" A" Aav A

I Uva x, ¥ Av £+ A~

2

Iy | Font N
|_1--|I-|-e---l'--1

Figure 3.9. Copy from Home

After you have selected the text, Right click and click on Copy, as it is
shown Figure 3.9 above. Alternatively, go to the Home tab and click
on the Copy and then click on Paste.

V. Cut and Paste

Word processor allow us to cut and paste the same portion of a text
throughout the document as long as the text remains on the clipboard.
For example, to cut and paste a text, the following steps are important.

1. Select the text.

2. Right click and choose Cut option.

3. On the clipboard, group on the Home tab, click the Cut option
or

4. Placetheinsertion point where you want the text to be inserted.

5. On the clipboard, group on the Home tab and click the Paste.

*

Right click and choose Paste.
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Type a paragraph about Addis Ababa and Copy, and Paste paragraph
as shown in the Figure 3.10 below.

AutoSave Z)v O @D v v

File Home Insert Draw Design Layout  References N

|

Calibri (Body) vHH o A A Aav | A

B I U+va x, ¥ Ay £+ A~

Clipboard Iy

v <X Format Painter !
| Font N

| e gll

Figure 3.10. Paste from Home Button

Right click on the paragraph and select Cut option, as it shown in the
above Figure 3.10. As an alternative, you can also select Home tab and
choose Cut and then Paste, as shown in the Figure 3.11.

e Cro
EEIGCE Insert  Design  Layouf Wailing fiew @ Tell me.. Signin
== 3 || Calibri (Body)
W - = B Copy é)" 2
I Ey | B I U -abe x, x* %o = - -
Paste Ty Paste Options: Styles  Editing
& ¥ A-W-A-na- A i L8 - -
Clipboard s Font o T = Styles = ~
Addis Ab & tyeerine. ty of Ethiopia

Save

e

Addis Ababa, Ezu ;tpﬂo ) vling capital in the
highlands bordering the Great Rift Valley, is the
country’s commercial and cultural hub.

Pagelof1 26o0f26words [J2 English (United States) EE B - i + 68%
AutoSave DO ® v =
File Home Insert Draw Design Layout References N
2 T I PR
& Cut ‘Calibri (Body) ~11 v AT A Al A
pm——_|=) COPY

‘BI_Livabxz)(aAvﬂvAv

~ <¥ Format Painter

Figure 3.11. Cut a text and Paste from Home
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VI. Formatting

Bold: is a set of characters that are darker and heavier than normal.
A bold font implies that each character is originally designed with
a heavier appearance other than created on the fly from a normal
character. For example, Bold (See the Figure 3.12 below).

Italic: is style of font that slopes the letters evenly to the right. For
example, this word is italicized (See the Figure 3.12 below).
Underline: is a section of text in a document where the words have a
line running extend them for example underline (See the Figure 3.12
below).

Insert  Design Layout References Mailings Review View Q Tell me... Sigh in Q_Share

<= X, | Calibri (Body) Ja SJlE-E | EE As | o :
s B3 |B I U-acx, x|l =Bl==|1=- SJES —
. ¥ BD-F-A-ra- | A x| DR - -
Clipboard = Font [P Paragraph | Styles A

Addis Ababa Capital City of Ethiopia w

Addis Ababa, Ethiopia’s sprawling capital in the
highlands bordering the Great Rift Valley, is the
country’s commercial and cultural hub.‘

Figure 3.12 Bold, Italic and Underline types

Font Type and Size: There are various default font type and
font size in word processor, as it shown in the Figure 3.13 font
type and Figure 3.14 font size.

O~ D @~ v = @~ =
sert Draw Design Layout References Mailings .
Draw Design Layout References
Calibri )»|1 AT AT Aav Ao | = v is
R == - Calibri (Body) 11 |[VA AT Aa~ | Ao
er - 1
& Calibri Light (Headings) B I U « abfl 8 -~ 2 A~
. Calibri (Body) 9
~
Recently Used Fonts - 10
: 3 e O : ) s 4
Times New Roman 11
Abadi Extra Light 12
Bavhaus 93 14
Symbol ABXSEGI nigp 16
Hobo Std
18

Figure 3.13. Font type  Figure.3.14. Increasing and decreasing font size
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To increase and decrease the font size of your text, you can select the
number of size, as it shown in the Figure 3.14 above.

Text Color: is used to emphasize a particular text and allow you to
change the font color of your text. To change the font color of your
text you can select a color from color options. For example, the red
color is selected, as it shown in Figure 3.15 below.

Theme Colors

H EEESEEEN

Standard Colors
1 EEEEN

T

Figure 3.15: Font color options

Activity 3.3
y N

m  Write a paragraph about the history of Ethiopian airlines
using word processor and it show to your teacher.

N J
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— 3.6. Spreadsheet —

Brainstorming activity

%@%\ ® Do you know how to perform subtraction,
a addition, multiplication and division using

Spreadsheet is an application used to organize and calculate data in
cells. It is a data file made up of rows and columns. It is used to sort
data and allow a user to manipulate and arrange data easily. It is used
to calculate values using mathematical formulas in the cells. See the
opened new spreadsheet in Figure 3.16 below.

Book] - Excel = = O X
Formulas Data Review View Q Tell me... Javier Flores g_ Share
'“‘ & ‘Calibri '|11 " == = %‘e !General " %Condiﬁonal Formatting ~ i‘ﬁ“lnser’( 2 el
> E~v B I U~ A A === + $+ % s [4FormatasTable~ &% Delete ~ Ednng
a, ¢~ e Dy A - EES= - S0 [;jCeIIStylesv Formatv -
Clipboard & Font ~ Alignment (] Number ~ Styles Cells A~
A1 - 5 | v
| A | B | ¢ | p | E | F | 6 | H J |k | [
1 | B
— ]
2*
3,_
44
57_
6;
7..
8 | |
0 [
10, ‘
11 L
12
15
e
15] -
Sheetl | Sheet2 | sheets | (@ i [ 1 D]
Ready o FH o - i + 100%

Figure 3.16: Opened New Spreadsheet

Once spreadsheet is opened the important buttons, rows, columns,
and headers appear. See the Figure 3.17 below.
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| Quick Access Toolbar . J_ Title bar l
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Figure 3.17. Elements of spreadsheet

Spreadsheet helps to create tables in rows and columns. The tables
allow you to analyze your data in spreadsheet quickly and easily. See
the Figure 3.18 below.

Book1 - Excel

NS Page layout Formulas Data Review View Q Tellme.. Signin g_ Share

|2 |8 gl -1 =l 7 B |8 4
. 17 M~ il - i~ I IS - : = ‘
Tables Wllustrations| Add- = Recommended :  PivotChart 3D Sparklines Filters  Links Text‘ »
i i ins~ Charts L RS 4 5 Map - 2 & ' 4
Charts f Tours A
A2 " P fe ‘ Type
| e - T - - T - )[4
1 | Create Table ? xX B
2 |Type ]Quantity Price
'3 |Mango  2kg 100 Birr Woeteisthe dataforyouetabler. i
4 [Banana Skg 150 Birr |-saszsCse i
5 |Tomato |9kg 27 Birr : Il
6 |Potato |8kg 12 Birr R
7] | oK | ( Cancel T Ll
|EQE i bd
Sheet1 @ Kl ]
Ready Count1s | FH = I + 100%

Figure 3.18: Creating table in spreadsheet
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There are two basic ways to perform calculations in formulas and
functions using spreedsheet.

I. Formulas
In spreadsheet, a formula is an expression that operates on values in
a range of cells or a cell. For example, =B2+B3, which finds the sum of

the range of values from cell B2 to cell B3.
To create a formula that refers to values in other cells,

1. Select a cell;

| A [ B

2. Type the equal sign (=) in the cell B4. i
2| x 15396
3 x 15
4] w5

Note: Formulas in spreadsheet always begin with the equal (=) sign.

A B
3. Select a cell or type its address in the ol Subistract
selected cell. 2| x ¥ 15396
3| Y 15
s w [ ]
| A' E
4. Enter minus operator into cell B4. 1 jSubstract |
2| X | 153961
3 Y 15
e w
5. Select the next cell B3, " 5
or type its address in the selected cell. ; i T
2| X [|__ 15396
»| v i
4| w |=B2-B3 |




Unit 3: Computer Software Grade 8

6. Press Enter. The result of the calculation

appears in the cell with the formula. A T
1 Substract
B 15396
3 5 15
4w 15381

II. Functions

Functions are predefined formulas in spreadsheet. Functions can
be used to perform calculations. The structure of a function begins
with an equal sign (=), followed by the function name, an opening
parenthesis, the arguments for the function separated by commas,
and a closing parenthesis. Some of the functions in spreadsheet are
sum, average, maximum and minimum. For example in the Figure
3.19 the function is: =SUM(C3:C6).

H - s Book - Excel B = B X
File Home Insert Page Layout IV Data  Review  View Q Tell me... Signin ,O+ Share
fx > AutoSum | Logical ~ %~ =) i
k- - . {285
o > Sum | fi Defined = Formula = Calculation i)
Function fe&Time~ B~ Names- Auditing~ Options -
Count Numbers Calculation ihd
|
7 | Moax fe | =suMm(c3:Ce) ca - | i [ =sume2sa)/3] [-averace(eaBa)| v
Min ? A
4 | A 8 C D E -
| N R,
1 ‘ More Functions... 1 h “F ge
: . 2
2 |Type Quantity Price 3 |Feb 42 ‘
3 |Mango 2kg 100 Birr 4 |war 50 ] “ .
- 5 |Apr 60 51 51
4 |Banana 5kg 150 Birr 5 |May = = =
5 |Tomato 9kg 270 Birr 7 lun 79 70 70
6 |Potato 8kg 120 Birr g [l 85 78 78
7 MC3:C6 9 |Aug 81 82 82
Sheet1 ® 2[4 1]
Enter BH o - —+ S

Figure 3.19 Functions in Spreadsheet

/ Activity 3.4 A\

®m  Create a file and enter your information such as your
name, age, gender, grade, test one and test two. Find
the sum of your test by using a spreadsheet.
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Brainstorming activity

%@ ®m Do you know how to prepare a power point
T presentation?

A power point helps to create a slideshow that addresses a topic or
presentation. Sometimes power point is known as a presentation or

slide. It typically includes three major functions:

®

» an editor that allows text to be inserted and formatted.

/

< a method for inserting and manipulating graphic images.
% aslide-show system to display the content.

Presentation! - PowerPoint Garnet Indezine &3l =

Design  Transitions Animations Slide Show Review View iSpring Suite 8 Q Tell me

o X =- | 1 === O (2
D#u L; " | ‘ . r<>‘f> - 1 \p‘

N B I U S achY [ il
Paste New .— | il - Shapes Arrange Quick _ Editing
+ N g B | F AR AL |RIEEEE O - o7 syl @ x
Clipboard & Slides Font (51 Paragraph F Drawing r A

|
1
Ciicktoadd subtitle

Siide 10f 1 Office Theme® = Notes 7[E| 0 B g -—4— + 40%

Figure 3.20 Power Point
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I. Insert Slide

The presentation contain one slide with the title ‘Slide layout’. It helps
to insert as many slides as needed from a variety of layouts, as shown
in Figure 3.21 below.

m HOME IMSERT DESIGM TRAMSITIOMS AMNIMATI

- v

Paste ‘. B I U § abci- Aa A

Clipboard T | Office Theme

1
Title Slide Title and Content Section Header
Figure 3.21. Inserting a new Slide

II. Copy and Paste

Click on the slide and select Copy from Home tab, as shown in Figure

3.22 below.
If"l J{, Cut

E@ Copy ~

Paste . =

v @ Copy ‘

[C1 Duplicate ‘

Figure 3.22. Copying Slide
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Then Right click and select Paste option, see Figure 3.23 below.
BEH ©9- O e =

o | I

36 Cut L__

E@ Co % —

Paste R Py MNe

- % Format Painter Slia
Paste Options: M=

= =
=Bl

Paste Special...

Figure 3.23 Paste

III.Cut and Paste Slides
For example to cut and paste the slides, the following steps are
important:

1. Select the slide you want to cut.

2. Right click on the slide.

3. Then click on Cut option.

Right click on the slide and choose the Cut option, as shown in Figure
3.24 below.

Paste Options:
P -

il — A
Slide 2 of 11 -] New Slide

=l

i Duplicate Slide
S"(_' Delete Slide

= Add Section

Figure 3.24. Cuting Slide

Then click on Paste option to paste your slides, as shown in Figure

3.23 above.
==l
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V. Delete the Slides

Right click on the slide and choose delete option, as depicted in Figure
3.25 below.

[ = =
= W
(2] New Slide

5] Duplicate Slide

7

_|GR Delete Slide
& Add Section b

|- I g I | EG Publish Slides

\ == CheckforUpdates  »

[Z] Layout »
y!
=] Reset Slide

Format Background...

Figure 3.25: Delete Slides

Activity 3.5

A/\/rite a tale you know in your village and present to your class\
using a power point.
Instructions:
1. Italicize, bold and underline the topic of your tale.
2. Insert page number to your slide.
3. Use any colour you want, example, blue color.
4. Save it by your name.

\ J
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Summary

In this unit, you have learnt about operating system, utility, driver
software, word processor, spreadsheet and power point presentation.
The following are summary of this unit.

B An operating system is system software that manages
computer hardware and software resources, which pro
vide common services for computer programs.

m  Utility software manages matters associated with the
analysis, configuration, performance, and maintenance
of a computer system.

m  Utility software are system utilities, storage device, man
agement utilities, file management utilities, and miscella
neous utilities.

m  Driver software is a type of software program that con
trols hardware devices.

m  Application software is the general designation of computer
programs for performing tasks.

m  Application software includes word processing,
spreadsheet and PowerPoint presentation.

m  Word processor is a software program capable of creat
ing, storing, and printing documents.

®m  Spreadsheet is a data file made up of rows and columns
that are used to sort data and allow a user to manipulate
and arrange data easily, commonly numerical data.

®m A power point presentation is software that helps to cre
ate a slideshow that addresses a topic or presentation.
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Review Questions

Part I: Say “True” if the statement is correct and “False” if it is incorrect.

1.

Application software used to perform calculation is called power
point.

. Utility software allows the peripheral devices to communicate with

the operating system.

Anti-virus is a software used to store and configure data on the
computer.

A software that helps to create presentation on a topicis spreadsheet.

. Operating system is a system software that manages both hardware

and software.

Part II: Choose the correct answer for each of the following questions.

1.

What would be the a correct formula for sum in spreadsheet?

A.=SUM(B3:B9) C. SUM(B3:B9)
B. =SUMB3+B9 D.=ADD(B3:B9)

2. Which area on the File tab has the command allowing a word doc-

ument to preserve a file?

A. Info C. Save As
B. Share D. Options

3. The application software that is used to prepare a presentation is

A. Spreadsheet C. Browser

B. Word Processor D. Power Point

4. Which one is not utility software?

A. System Utility C. Miscellaneous Utilities
B. Management Utilities D. None
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hardware and software.
A. Utility Software
B. Driver Software
C. Operating System

D. Anti-virus

Part III: Demonstrate the following questions.
1. From the following table, demonstrate the sum and average of the

student result using spreadsheet.

is system software that manages computer

Student Name Mathematics Chemistry | Biology | Physics | English | Sum | Average
Lattuu Walabuma | 89 85 93 82 75
Kebede W/Mariam | 75 87 90 73 82
Zabarga Hussen 65 89 87 75 89
Fatuma Jemal 89 78 65 78 79
Hagos Getachew 79 89 74 89 76
Ujulu Osman 67 87 75 75 89
Ayde Ergando 81 74 87 87 78
Obsineet Workineh | 87 78 88 94 98

2. Prepare a short power point presentation about your biography.
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Unit Outcomes

At the end of this unit, students will be able to :

W describe internet services; W explain uses of the email and

social network;
W explain the di%erence between
- W create email address and ex
change mail,

internet and

W explain file transfer and text
transmission protocol; W create Facebook and telegram
account and
W browse information on the
internet; W benefits and risks of social
networks

J G
Overview

Dear students, in grade 7 you have learned the definitions of the internet,

WWW, web page, website, browser, search engine, web server, and web

addresses. In this unit, you will learn about internet services, WWW,

file transfer, text transmission protocol, browsing information on the

internet, email and facebook and benefits and risks of social networks.

A\ 4

% m  Discuss the major uses of the Internet that play a
vital role in daily life.




4.1. Internet Services

Computer network is when two or more computer systems are
connected together. Internet refers to network of networks. Internet
is a world-wide global system of interconnected computer networks.
The internet is the largest computer network in the world connecting
millions of computers. World Wide Web (WWW), E-mail, Telnet
and file transfer protocol (FTP) are some of the internet services that
facilitate access to internet resources.

4.1.1. World Wide Web

World Wide Web (WWW) is a collection of websites or web pages. It is
known as a Web. The World Wide Web or Web is a part of the internet.
The Web was invented in 1991 by Tim Berners-Lee. It is connected to
local computers through the internet. Users can access the content of
sites from any part of the world over the internet using the devices
such as computers, laptops, and cell phones. The WWW is viewed
through web browsers such as Google Chrome, Internet Explorer and
Mozilla Firefox. By using the browsers, one can access a web page
from the internet.

Web page

webpage is a document available on WWW. Web pages are stored on
a web server and can be viewed using a web browser. A web page can
contain large information including text, graphics, audio, video and
hyperlinks. Hyperlinks are the link to other web pages. A collection
of linked web pages is known as a website. Each web page has its
unique Uniform Resource Locator (URL). A URL is an address to a
web page on the internet. A URL has two main components. they are
protocol identifier and resource name. For example URL: http://www.
google.com/. For this URL, the protocol identifier is hypertext transfer
protocol hitp and the resource name is www.google.com. Web pages
are categorized into static web pages and dynamic web pages based
on the information they contain.
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Static web page

Static web pages contain only static information i.e. user can only read
the information but cannot do any modification or interact with the
information. Static web pages are only used when the information is
no more required to be modified. A static web page remains the same
until it is updated.

Dynamic Web page

A dynamic web page or dynamic website contains information that
changes depending on the viewer, the time of the day, the time zone
and the viewer’s native language. A dynamic web page automatically
changes daily to give visitors a new content.

4.1.2. File Transfer Protocol (FTP)

FTP is one of the internet services that are used for transferring files
from one system to another using internet. FTP is a way to download,
upload and transfer files from one location to another on the internet
and between computers. FTP is also used to transfer files when the
file size is large or when several files are transferred which are difficult
to transfer using email.

4.1.3. Hypertext Transfer Protocol

HTTP stands for hypertext transfer protocol. It is used to access data on
the World Wide Web. HTTP has a server (service) and client (request)
communication protocol. HTTP is also used for formatting and
transferring web page data (text, images and video) over the World
Wide Web. It is used to create communication between Web servers
and Web users. It acts as a request-response protocol. For example, a
client who uses a web browser and a server is a Web host that hosts the
website. Whenever a client transmits a request to the Website server,
the HTTP proceeds that request and creates a connection between the
client and the server through Transmission Control Protocol (TCP).
Then HTTP sends a request to the server, which picks up the requested
data from database, and HTTP sends the response back to the client.

HTTP functions as a combination of FIP and Simple Mail Transfer
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Protocol (SMTP). The HTTP protocol is like SMTP protocol because
the data transferred between the client and the server look like SMTP
messages. However, HTTP differs from SMTP on how the clients’
messages are sent to the server and from the server to the client.
Unlike SMTP, the HTTP messages are not read by humans; they are
read and interpreted by the HTTP server and HTTP client (browser).
SMTP messages are stored and forwarded, but HTTP messages are

delivered immediately. There are others protocols such as Internet
Message Access Protocol (IMAP) and Network Time Protocol (NTP).

4.2. Browsing information

Brainstorming activity

e
é@”% In groups, discuss what we can search on the
internet.

Browsing information is searching or finding information on the in-
ternet. Internet searching is one of the easiest and useful ways to get
useful information on the internet by using different search engines.
Search engines make this information easier to find. People use
common search engines such as Google and Yahoo to find images,
books, currency conversions, definitions of words, news and movies.
The most popular search engine these days is Google.

To search information on the internet, first open a search engine using
a web browser. After you have opened the search engine, type one
or more keywords also known as search terms; then press Enter on
your keyboard. For example, we can search for what is computer?’.
See figure 4.1. — — = E

<« C @& googlecom 9 arx @& »0O0@ :

ges i g

Google

what is computer?| » U]

what is computer?
what is computer system

what is computer virus

what is computer science

Figure 4.1: How to type keyword on Google search engine
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Then, a list of relevant websites that match what you searched will be
displayed. These are commonly known as search results. If you see a
site that looks interesting, you can click a link to open it. If the site does
not have what you need, you can return to the results page to look for
more options. Figure 4.2 shows how we search for information from
the internet.

AT AL LULIPULED T OUUYIT St A o

- C B google.com/fsearchig=what+is+computer®%., @ @ 1@ v+ @ B » 0O @a H

-

GO g|e what is computer? ¢

https:#edu.gcfglobal.org > computerbasics > what-is-a-c...

Computer Basics: What is a Computer? - GCFLearnFree.org
A computer is an electronic device that manipulates information, or data. It has the ability
store, retrieve, and process data. You may already know that ...

hitps:/Awww.computerhope.com > ... > C - Definitions

What is a Computer?
Jul 2, 2022 — A computer is a programmable device that stores, retrieves, and processe _

Figure 4.2: Searching information from the internet

Activity 4.1

®  Browse the information from the internet such as
Abay River and famous athletes in Ethiopia.

— 4.3.  Electronic Mail (Email) —

Brainstorming activity

o

%@% ®m Have you ever used email? If so, for what purpose did
you use it?

Email is a way to send and receive messages using the internet. It
offers an efficient, inexpensive and real time means of distributing
information among people. There are many different email services
available that allow you to create an email account, send and receive
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email and attach files for free. Figure 4.3 below shows the different
email services.

7
NG

Outlook Gmail

Figure 4.3: Yahoo, Outlook and Gmail icon

I.Creating Email

Google mail (Gmail) is one of the most used email services around
the world. If you want to create a Gmail account, you need to provide
some basic information like your name, birth date, gender, and
location. Even you have to choose aname for your new Gmail address.
Follow the steps below to create Gmail account with the quick sign-
up process.

Step 1: Visit Google account creation page, /1ftps://accounts.google.
com

Step 2: Click on Create account.

Step 3: The sign-up form will appear. Enter your first and last name.

Step 4: Choose a Username for your account.

Step 5: After choosing a username, enter a password. Type the
password again to confirm. As per the Google’s instruction,
always use 8 or more characters with a mix of letters, numbers
and symbols.

Step 6: At last click on Next, Right corner of the screen.

Step 7: On the next page, enter your phone number to verify your
account. It is a two-step verification process for security.

Step 8: On the given mobile number, you will receive a text



